The Fate and Prognostic Implications of Hyperreflective Crystalline Deposits in Nonneovascular Age-Related Macular Degeneration

Serena Fragiotta,1,3 Pedro Fernández-Avellaneda,1,2,4 Mark P. Breazzano,1,2,5,6 Christine A. Curcio,7 Belinda C. S. Leong,1,2 Kenneth Kato,1 Lawrence A. Yannuzzi,1,2,5,6 and K. Bailey Freund1,2,5,6

1Vitreous Retina Macula Consultants of New York, New York, New York, United States
2LuEsther T. Mertz Retinal Research Center, Manhattan Eye, Ear and Throat Hospital, New York, New York, United States
3Department of Medico-Surgical Sciences and Biotechnologies, U.O.S.D. Ophthalmology, Sapienza University of Rome, Rome, Italy
4Department of Ophthalmology, Basurto University Hospital, Bilbao, Spain
5Department of Ophthalmology, New York University School of Medicine, New York, New York, United States
6Columbia University College of Physicians and Surgeons, Harkness Eye Institute, New York, New York, United States
7Department of Ophthalmology and Visual Science, University of Alabama at Birmingham, School of Medicine, Birmingham, Alabama, United States

Correspondence: K. Bailey Freund, Vitreous Retina Macula Consultants of New York, 950 Third Avenue, New York, NY 10022, USA; kbfnyf@aol.com.
Submitted: January 7, 2019
Accepted: May 11, 2019

PURPOSE. To explore patterns of disease progression in nonneovascular age-related macular degeneration (AMD) associated with hyperreflective crystalline deposits (HCDs) in the subretinal pigment epithelium–basal laminar space.

METHODS. Retrospective review of medical records, multimodal imaging, and longitudinal eye-tracked near-infrared reflectance (NIR) and optical coherence tomography (OCT) spanning ≥2 years. NIR/OCT images were analyzed with ImageJ software to identify HCD morphology and location. Associated macular complications were reviewed from the time of HCD detection to the most recent follow-up, using NIR/OCT.

RESULTS. Thirty-three eyes with HCDs from 33 patients (mean age: 72 ± 7.5 years) had 46.7 months (95% confidence limits: 33.7, 59.6) of serial eye-tracked NIR/OCT follow-up. Baseline best-corrected visual acuity (BCVA) was 0.44 logMAR (Snellen equivalent 20/55). At a mean of 11.3 months (3.1, 19.6) after HCD detection, 31/33 (93.9%) eyes had developed macular complications including de novo areas of complete retinal pigment epithelium and outer retinal atrophy (cRORA) in 21/33 (64%) eyes, enlargement of preexisting cRORA in 4/33 (12%) eyes, and incident macular neovascularization in 3/33 (9%) eyes. Movement and clearance of HCDs in 9/33 (27%) eyes was associated with enlargement of preexisting cRORA (r = 0.44, P = 0.02). BCVA at the last follow-up visit had decreased to 0.72 logMAR (20/105).

CONCLUSIONS. Eyes with nonneovascular AMD demonstrating HCDs are at risk for vision loss due to macular complications, particularly when movement and clearance of these structures appear on multimodal imaging. HCD reflectivity and dynamism may be amenable to automated recognition and analysis to assess cellular activity related to drusen end-stages. Keywords: cholesterol, crystals, age-related macular degeneration, hyperreflective crystalline deposits, spectral-domain optical coherence tomography, macular neovascularization, complete retinal pigment epithelium and outer retinal atrophy, drusen, refractile deposits
been associated with the development of multifocal patches of macular atrophy. Querques et al. have found similar highly reflective lines on OCT that are obliquely oriented (i.e., separate from and floating above BrM) within regressing drusen. These authors hypothesize that coiled, membranous debris (soft creme material) accumulating between RPE and BrM may calcify during drusen progression, further postulating a split and inward bowing of BrM to account for the position and orientation of the lines. Others have illustrated similar highly reflective lines on OCT and also attributed them to calcification of drusen.15

Distinctive multilayered lines corresponding to mirror-like reflective plaques in clinical NIR imaging have been found within vascularized pigment epithelial detachments in neovascular AMD and called by one of us (KBF) the “onion sign.” Demonstration that the onion sign could represent cholesterol crystals has come from subsequent histopathology, in which solvents used for tissue processing dissolve the crystals and create a space in the tissue known as “cholesterol clefts,” a process well known from cardiovascular histopathology. To form the clinically recognizable onion sign, an aqueous environment in the sub-RPE–basal laminar (BL) space is hypothesized to permit supersaturation and precipitation of cholesterol derived from dying cells, plasma exudate, or both.16 Cholesterol crystals confirmed by polarizing microscopy of fluid aspirates also form in Coats disease, and in this disorder, highly reflective linear structures on OCT B-scans correlate with needle-like clefts on histology.20 Crystallization can also occur in environments with less fluid. Cholesterol clefts reported within fibrovascular scars of neovascular AMD in 1977 were directly correlated to highly reflective lines in clinical OCT in 2018.22 Recently, our group published a clinicopathologic correlation of an eye with GA secondary to nonneovascular AMD and called by one of us (KBF) the “onion sign.” We identified, as the source of hyperreflectivity, cholesterol clefts within avascular fibrosis, a material that can replace drusen contents. Since the molecular composition of crystals was not directly assayed in these studies, we have chosen to describe their OCT signatures in this report, calling them “hyperreflective crystalline deposits” (HCDs).

Little is known about specific clinical AMD phenotypes leading to HCDs in nonneovascular AMD, the fate of HCDs once present, and the natural course of eyes demonstrating these lesions. We sought to answer these questions through a retrospective review of multimodal imaging, including longitudinal eye-tracked NIR/OCT, in eyes showing HCDs associated with nonneovascular AMD at some point during their follow-up. Herein, we explored prognostic implications of HCD, their association with other AMD-related fundus findings, and their evolution over an extended follow-up. In a related manuscript in preparation, we will define precursor lesions leading to the appearance of HCDs.

METHODS

This was a retrospective review of medical records and retinal imaging from patients with nonneovascular AMD associated with HCDs at some time during their follow-up who were examined between November 2008 and February 2018. Each patient had been examined by one of two retinal specialists (KBF, LAY) at Vitreous Retina Macula Consultants of New York, a large tertiary referral practice for retinal diseases. This study adhered to the tenets of the Declaration of Helsinki and complied with the Health Insurance Portability and Accountability Act of 1996. It was approved by the Institutional Review Board (IRB) committee at the Western Institutional Review Board (IRB).

Inclusion criteria were presence of highly reflective subretinal or sub-RPE lines on OCT B-scans colocalized to irregular highly reflective mirror-like lesions on NIR; ≥ 2-year follow-up with serial, eye-tracked OCT B-scans; and complete medical records. Exclusion criteria included an interruption in the sequence of tracked OCT B-scans before the 2-year follow-up, media opacities preventing high-quality OCT, vitreomacular interface disorders (i.e., vitreomacular traction or macular pucker), evidence of retinal vascular disease or other retinal disease associated with retinal edema and/or lipid deposition, or the presence of macular neovascularization (MNV) or RPE tear at baseline.

Medical history concerning cardiovascular events and risk factors was reviewed because use of lipid-lowering medications has previously been reported, by Pang et al., to be associated with HCDs in neovascular AMD.

Clinical Staging

HCDs were defined on OCT as highly reflective lines located anteriorly to BrM and posteriorly to any remaining RPE attached to either its native basal lamina or basal laminar deposit (BLamd), that is, in the sub-RPE–BL space. The HCDs had either a single linear or multiline appearance on OCT B-scans with a corresponding hyperreflective plaque on NIR. On clinical ophthalmoscopic examination, the HCDs appeared as brilliant yellow lesions, typically within areas of hypopigmentation and distinct from accompanying drusen (Fig. 1). Some eyes had HCDs at multiple locations. In some eyes, HCDs occurred in clusters (Figs. 1D, 1E).

In patients with bilateral HCDs, one eye was randomly selected as the study eye. OCT B-scan data and related multimodal imaging were reviewed independently by two graders (SF, PF-A). In case of disagreement, a senior retinal specialist (KBF) was consulted to resolve the discrepancies between graders by open adjudication.

Refractile Drusen and Macular Complications

Refractile drusen or “calcified drusen” were identified as chalky-white, shiny or glistening in appearance on ophthalmoscopy and could appear similar to HCDs on color photography. However, refractile drusen show heterogeneous internal reflectivity (HIRD) and a hyperreflective core, now attributed to “calcific nodules,” in contrast to the linear shape of HCDs (Fig. 2).

Drusenoid pigment epithelial detachment (PED) was defined according to Age-Related Eye Disease Study as a pale yellow or white large mound measuring at least 500 μm in the narrowest diameter with an elevated appearance on stereoscopic color fundus photographs. Drusenoid PEDs are distinguishable from serous and hemorrhagic PEDs by clinical features revealed on ophthalmoscopy and fluorescein angiography (FA). MNV was defined as new vessel growth detected with FA and or OCT angiography. Complete RPE and outer retinal atrophy (cRORA) met diagnostic criteria of the Classification of Atrophy (CAM) Report 3 as follows: (1) a region of hypertransmission at least 250 μm in diameter; (2) attenuation and/or disruption of the RPE at least 250 μm in diameter; and (3) loss of overlying interdigitation zone, ellipsoid zone (EZ), and external limiting membrane (ELM) as well as thinning of the outer nuclear layer. Incomplete RPE and outer retinal atrophy (iRORA) was defined as irregular or interrupted EZ, ELM, and RPE band with
The border of cRORA was determined by both the presence of choroidal hypertransmission and descent of the ELM toward BrM on each cross-sectional scan considered, as described.81

The Early Treatment Diabetic Retinopathy Study (ETDRS) grid was displayed and centered on the NIR image by using an SD-OCT cross-sectional scan to reference the foveal center. cRORA within the central 1-mm diameter subfield of the ETDRS grid was graded as involving the foveal center in any case. The fovea was graded as spared in presence of foveal depression with preserved inner and outer retinal layers.32 In case of foveal sparing, if the greater extension of cRORA was located between central subfield and the 3-mm (outer) diameter ring it was graded as parfoveal; and between 3-mm and the 6-mm (outer) diameter ring, as perifoveal.

**Multimodal Imaging**

SD-OCT was performed with Spectralis HRA+OCT (acquisition software version 6.8.1.0; Heidelberg Engineering, Heidelberg, Germany).

When available, the OCT scan pattern used for analysis was 30° × 20° (8.8 mm × 5.7 mm) centered on the fovea and composed of 49 B-scans with a nominal interscan distance of 121 μm. The minimum acceptable scan pattern was 20° × 15° (5.8 × 4.3 mm) centered on the fovea with a maximum nominal interscan distance of 224 μm. To minimize speckle noise and enhance visualization of ELM descent,31 automatic real-time tracking (ART) mode was typically set between 10 to 20 frames and Scan Quality Factor ≥ 25 decibels. NIR was acquired simultaneously with SD-OCT B-scans by using an excitation wavelength of 870 nm.33

Color photographs, fundus autofluorescence, and red-free images were obtained by using Topcon TRC-50DX fundus camera (Topcon Medical Systems, Paramus, NJ, USA). Fundus autofluorescence images were obtained by using an excitation filter of 535 to 580 nm and a barrier filter of 675 to 715 nm. Red-free digital monochromatic photographs were obtained by using the standard green filter of the fundus camera.34

**Characterization of HCD Movement**

To estimate a rate of HCD movement in the sub-RPE–BL space, individual HCDs were followed and their positions recorded in a foveocentric coordinate system. NIR images from the SD-OCT device were extrapolated by using the “extract fundus image” function and then exported as a tagged image file (TIFF) format. Serial NIR images were aligned (Photoshop Creative Cloud, version 20.0.1; Adobe Inc., San Jose, CA, USA) as follows: Go to File > Scripts > Load Files into Stack, select all layers, and Edit > Auto-Align Layers. Aligned images were saved (File > Scripts > Export Layers to Files) for analysis with the open source imaging processing software FIJI (software version 2.0.0-rc-68/http://fiji.sc).35

Spatial calibration of serial NIR images on ImageJ (Analyze > Set Scale) was obtained by using the factor scale provided by Heidelberg software for each case (Image > Info). However, since individual variations in corneal curvature were not entered in the Eye Data field during acquisition mode, the default axial length (and thus default ocular magnification) was automatically calculated by the software. To bypass inaccuracies in lateral scaling factor (μm/pixel in x- and y-direction) distance measurements were reported as degrees. Before tracking HCDs, the foveal center was identified by using anatomic hallmarks in cross-sectional SD-OCT: foveal depression, centripetal displacement of inner retinal layers and outer plexiform layer, outer nuclear layer thickening, and inward rise of the ELM and EZ. Once the foveal center was identified and labeled, the cursor was moved over the center by using ImageJ (http://imagej.nih.gov/ij/; provided in the public domain by the National Institutes of Health, Bethesda, MD, USA), and the coordinates displayed on the status bar were input and set with “Origin (Pixels)” (Image > Properties > Origin (Pixels)).

HCDs were manually selected by using the polygonal selection tool at each follow-up time point, and coordinates were obtained by using Analyze > Measure function in FIJI. In cases of multiple HCDs, each single HCD was independently tracked (e.g., Track1, Track2).
Statistical Analysis

LogMAR best-corrected visual acuity (BCVA) was calculated by the procedure of Holladay\textsuperscript{36} and reported along with Snellen equivalent. Distribution normality was verified through Shapiro-Wilk normality test. Spearman’s rank correlation coefficient or Kendall’s tau coefficient was calculated to determine the existence of a monotonic relationship as well as the strength and direction between two variables on a scale that is at least ordinal. Multivariate analysis of variance for repeated measures was calculated for BCVA obtained at different time points. Means are reported with 95% confidence limits for nonnormal distribution. \(P\) values less than 0.05 were each considered statistically significant. All calculations were performed by using Statistical Package for the Social Sciences (SPSS) software (ver. 20; SPSS, Inc., Chicago, IL, USA).

RESULTS

A total of 76 eyes of 54 patients with AMD and HCDs were initially identified, of which 28 eyes of 21 patients were excluded owing to the presence of MNV at baseline (23/28, 82.14%), insufficient eye-tracked OCT follow-up (4/28, 14.3%), or concurrent macular pucker (1/28, 3.6%). In 15 patients with two eligible eyes, one eye was excluded at random.

Demographic characteristics for 33 study eyes of 33 patients are reported in Table 1. Regarding the use of statins, our population exhibited a rate (13/33 patients, 39.4%) similar to that of the general population in the United States (range, 39.1%–54.4%) but significantly lower than the cohort exhibiting an onion sign in neovascular AMD (11/15, 73%; \(P < 0.03\)), as previously reported.\textsuperscript{16-37}

Baseline Clinical Features

Baseline BCVA was 0.44 (95% confidence interval [CI]: 0.3, 0.6) logMAR (20/55 Snellen equivalent). By OCT, HCDs appeared between the RPE and BrM in all cases (Figs. 1C–F). In 31/33 (93.93%) eyes, HCDs were parallel to and not resolvable from BrM, and in 1/33 (3%) HCDs were parallel to and resolvable from BrM. In 1/33 (3%) eyes, HCDs were obliquely oriented with respect to the underlying BrM. In 26/33 (78.8%) cases, multiple HCDs were detected within the same eye. Clusters of HCDs were present in 24/33 (73%) eyes. On NIR, HCDs, either single or in clusters, appeared as hyperreflective roundish spots in all eyes (33/33, 100%). Multilaminar HCDs were detected on OCT in 17/33 (51.5%) eyes (Fig. 1). Refractile drusen were found in 11/33 (33.33%) eyes.

Longitudinal Analysis

The mean follow-up time with serial eye-tracked NIR/OCT was 46.7 months (95% CI: 33.7, 59.6). At the time of the most recent NIR/OCT evaluation, HCDs were still detected in 23/33 (69.7%) eyes. BCVA had declined to 0.72 (95% CI: 0.5, 0.9) logMAR (20/105), with a mean difference of 0.27 logMAR between the first and final visits (\(P < 0.001\)).

The BCVA decline over time (\(F_{2,51} = 9.8, P < 0.001\)) was significant between different time points considered in post hoc analysis, particularly with the disappearance of previously apparent HCDs (\(P = 0.02\)) and between HCD appearance and last visit (\(P < 0.001\)). Table 2 summarizes BCVA changes for each follow-up time considered.

The presence of multiple HCDs organized in clusters on NIR was also related with decreasing BCVA recorded at the time of HCD appearance (\(r = -0.51, P = 0.002\), HCD...
disappearance ($r = -0.47$, $P = 0.006$), and last follow-up available ($r = -0.47$, $P < 0.001$).

Thirty-one patients (93.9%) developed macular complications after a mean of 11.3 months (95% CI: 3.1, 19.6) from the first tracked OCT evaluation. The most common macular complication was incident cRORA in 21/33 (63.6%) eyes, followed by enlargement of existing cRORA in 4/33 (12.1%) eyes, MNV in 3/33 (9.1%) eyes, RPE aperture,$^{89}$ in 2/33 (6.1%) eyes, and lamellar macular hole in 1/33 (3%) eyes. cRORA involved the foveal center within the central 1-mm-diameter subfield of the ETDRS grid in 18/25 (72%) eyes, in the parafovea of 6/25 (24%) eyes, and the perifovea in only 1/25 (4%) eyes.

The mean duration of HCD visibility was 39.21 months (95% CI: 27.5, 51.13). This period was significantly higher among patients who developed MNV (79.4 ± 16.5 months, $P = 0.001$).

Hyperreflective Crystalline Deposit Turnover and Movement

HCDs exhibited a certain degree of remodeling associated with cRORA expansion, resulting in movement, clearance, or both, during follow-up. In 9/33 (27.3%) eyes, new HCDs appeared, with subsequent fragmentation and resorption in some cases. In 15/33 (45.4%) eyes, small collections of adjacent HCDs coalesced into larger aggregations which then showed partial or complete clearance (Fig. 3). In the remaining 7/33 (21%) eyes, clearance occurred without prior coalescence (Fig. 4). In only 2/33 (6%) eyes, the HCD morphology remain unchanged over the course of follow-up.

Movement of HCDs was detected in 9/33 (27.3%) cases. The presence of movement was associated with a progressive cRORA enlargement over tracked follow-up time ($r = 0.44$, $P = 0.02$) and inversely related to the presence of HCDs at last follow-up ($r = -0.63$, $P < 0.001$; see also Fig. 5 and Supplementary Video S1).

A total of 97 tracking points were analyzed in nine patients demonstrating HCD movement over time. Table 3 shows the main features of HCD movement characteristics in this patient subgroup. The total area occupied by HCDs was directly related to the distance from the foveal center ($r = 0.49$, $P < 0.001$). The rate of movement was 0.68 deg/mo (95% CI: −6.98, 5.62). All nine tracked eyes developed macular complications during the period of HCD movement and clearance (Table 4). De novo cRORA proceeded from iRORA in all cases (100%).

At the follow-up preceding HCD movement, all tracked eyes presented multiple HCDs (9/9, 100%) scattered around the central fovea in 5/9 (55.5%) cases, at the border of atrophy in 3/9 (33.3%) cases, and involving the foveal center in only 1 (11.1%) case. During movement, they tended to scatter at the border of atrophy in 7/9 (77.8%) cases, whereas, in the remaining 2 (22.2%) cases, they were distributed within the central fovea (1-mm-diameter ETDRS central subfield). HCDs were no longer visible in 7/9 (77.8%) cases at the end of tracking.

Movement coordinates of seven eyes that developed cRORA were recorded in 47 different tracking points and correlated with cRORA area measurements at each single point. Faster-growing cRORA was related to HCD proximity to the fovea ($r = -0.36$, $P = 0.02$).

At the most recent eye-tracked OCT examination, HCDs were located at the boundary of cRORA in 12/33 (36.4%) eyes, within the area of cRORA in 12/33 (36.4%) eyes, both locations in 3/33 (9.1%) eyes, at the edge of collapsed PED in 3/33 (9.1%) eyes without retinal atrophy, at the border of an area of drusen resolution in 1/33 (3%) eyes, within an RPE aperture,$^{89}$ in 1/33 (3%) eyes, and scattered around the area of retinal atrophy in 1/33 (3%) cases.

**DISCUSSION**

The present study investigated the fate and prognostic implications of HCDs in eyes with nonneovascular AMD. We demonstrated that HCDs are dynamic in nature with evidence for de novo production, fragmentation, conglomeration, and resorption. Eyes with HCDs developed macular complications in almost all cases (93.4%) after a mean longitudinal follow-up

**Table 1. Main Characteristics of the Study Group at Baseline**

<table>
<thead>
<tr>
<th>Subjects (n = 33 Eyes)</th>
<th>Age, mean (SD), y</th>
<th>71.83 (7.49)</th>
<th>Sex, female, n (%)</th>
<th>25 (75.8)</th>
<th>Visual acuity, mean (SD), logMAR</th>
<th>0.32 (0.5)</th>
<th>Bilateral, n (%)</th>
<th>15 (45.4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Systemic factors, n (%)</td>
<td>Hypercholesterolemia</td>
<td>16 (48.5)</td>
<td>Statin use</td>
<td>13 (39.4)</td>
<td>Hypertension</td>
<td>17 (51.5)</td>
<td>Cardiovascular disease</td>
<td>4 (12.1)</td>
</tr>
<tr>
<td>Fellow eye status, n (%)</td>
<td>MNV</td>
<td>14 (42.4)</td>
<td>PED</td>
<td>10 (30.3)</td>
<td>cRORA</td>
<td>4 (12.1)</td>
<td>NNV-AMD</td>
<td>4 (12.1)</td>
</tr>
</tbody>
</table>

**Table 2. Visual Loss in Patients With Hyperreflective Crystalline Deposit Turnover and Movement**

<table>
<thead>
<tr>
<th>Visual Acuity</th>
<th>LogMAR</th>
<th>Snellen Equivalent</th>
<th>Years From Baseline, Mean (SD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First HCD appearance</td>
<td>0.44 ± 0.21</td>
<td>20/55</td>
<td>-</td>
</tr>
<tr>
<td>HCD disappearance</td>
<td>0.64 ± 0.55</td>
<td>20/87</td>
<td>3.26 (2.8)</td>
</tr>
<tr>
<td>Last FU</td>
<td>0.72 ± 0.56</td>
<td>20/150</td>
<td>3.92 (3.1)</td>
</tr>
</tbody>
</table>

FU, follow-up.

**Table 3. Main Features in Hyperreflective Crystalline Deposit Migration Subgroup**

<table>
<thead>
<tr>
<th>Subjects (n = 9 Eyes)</th>
<th>Age, mean (SD), y</th>
<th>72.4 (7.9)</th>
<th>Sex, female, n (%)</th>
<th>7 (77.8)</th>
<th>Visual acuity, mean (SD), logMAR</th>
<th>0.3 (0.1)</th>
<th>Bilateral, n (%)</th>
<th>5 (55.6)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline distance from fovea, °</td>
<td>47.4 (28.5)</td>
<td>Final distance from fovea, °</td>
<td>31.9 (29.3)</td>
<td>Distance from previous location, °</td>
<td>18.4 (28.5)</td>
<td>Rate of movement, °/mo</td>
<td>0.68 (3.16)</td>
<td>Area of HCDs, global, μm</td>
</tr>
</tbody>
</table>

Euclidean distances were calculated for x and y coordinates; the movement was calculated by using fovea coordinates for each single case examined.
of 11.3 months from the first-tracked OCT. The most common complication was new cRORA (63.6%) or enlargement of established cRORA (12.1%) followed by MNV (9.1%). cRORA tends to involve the foveal region (72%) over the parafoveal location (24%). BCVA declined over time during HCD turnover, markedly deteriorating in relation to the interval between HCD appearance and disappearance. Coalescence of HCDs in clusters represented a further negative prognostic factor for visual acuity. Additionally, in some cases, HCDs moved along BM around the fovea, which was an important predictor for subsequent cRORA, as demonstrated by progressive enlargement of cRORA in relation to distance covered by HCDs. As previously reported, eyes with hyperreflective foci (odds ratio: 11.21) drusenoid lesions with heterogeneous internal reflectivity (odds ratio: 7) and refractile drusen (odds ratio: 6.36 to late AMD) also have an increased risk of progression into new atrophy onset.27,28,39 Although our study design did not allow calculation of odds ratio, the incidence of new cRORA (63.3%) of eyes was similar to the incidence reported for eyes with refractile drusen (59.1%).27

Our data add to growing literature that establishes the identity of reflective features signifying progression to advanced AMD. The distinctive OCT appearance of cholesterol crystals as hyperreflective linear deposits without shadowing due to their high transparency has been confirmed by direct clinicopathologic correlations between SD-OCT images and histopathology in several disorders resulting from chronic exudation.16,17,21,22 This pathogenic mechanism causing cholesterol clefts seen histologically validated the typical stratified hyperreflective lines visible on OCT, the so-called onion sign.16,17 Despite the undeniable role of chronic exudation, recent clinicopathologic correlations have identified cholesterol clefts corresponding to hyperreflective plaques on NIR and single hyperreflective lines lying on BrM on cross-sectional B-scan in nonneovascular AMD.23

Mirror-like hyperreflective lines that appear in or near BrM, representing sparse cholesterol crystals within the fluid or fibrotic material that replaces oily drusen, have been recently differentiated from calcified structures in drusen.28,22,40 Refractile drusen were first described by Suzuki et al.26 as mound-like elevations containing multiple hyperreflective dots now known from histopathology and microanalysis to originate from small highly crystalline whitlockite spherules.28 OCT reflectivity signatures of calcified structures associated with cRORA development include reflective dots (spherules) and HIRD with hyperreflective core and hyperreflective cap (nodules).28 Calcified plaques within BrM of older eyes have been long recognized but do not yet have a defined reactivit...
signature, although extensively calcified BrM, as in pseudoxanthoma elasticum, is reflective. Noteworthy, in our series, isolated linear or multilinear hyperreflective bands lying on BrM, described as HCDs and representing cholesterol crystals, were associated with refractile drusen in 33.3% of cases. Although the high resolution of modern OCT devices enables accurate matching to corresponding histologic findings, further evidence is needed to validate OCT features that may occur simultaneously during the drusen lifecycle.

Our data on HCDs should be contextualized with knowledge of the physical forms of cholesterol present at different stages of AMD, which is in turn informed by decades of research on cardiovascular disease. Cholesterol, an essential lipid with four 6-carbon rings, appears in two chemical forms (esterified [EC] and unesterified [UC]) and three physical forms (oily droplets, liposomes, and crystals) that differ by their relative content of EC, UC, and phospholipid. Cholesterol crystals are 100% UC, and they leave a readily detectable tissue symbol, because common extractive solvents in histologic processing remove cholesterol crystals and leave an empty cleft in the tissue. Cholesterol crystals are hallmarks of mature atherosclerotic plaques, where they are found in both extracellular (lipid-rich plaque core) and intracellular (foam cells, i.e., macrophages) locations. We previously have demonstrated that choroidal stroma and macrophages of hypercholesterolemic rabbits have cholesterol crystals visible by polarizing microscopy in unprocessed specimens and cholesterol clefts in histologically processed specimens.

Cholesterol crystals within vulnerable atherosclerotic plaque are visible with intravascular OCT as thin linear regions of high intensity and have been validated by histology. Intravascular OCT also reveals calcification as signal-poor regions, in contrast to the reflective crystals.

Histologic studies of early AMD have concluded that a major difference between AMD and cardiovascular disease, which both involve lipoprotein-instigated disease in a subendothelial space, is the absence of cholesterol crystals from BrM and drusen. All drusen in the sub-RPE–BL space contain EC and UC. The main component of soft drusen is loosely packed UC-rich whorls with EC lakes, together considered “membranous debris” by Sarks et al. This material was later termed “lipoprotein-derived debris” owing to multiple lines of evidence that it is derived from large apoB, E-lipoproteins secreted by the RPE, in a constitutive program of outer retinal lipid cycling. In contrast, histologic studies of late AMD eyes demonstrate cholesterol crystals in avascular fibrosis, serous PED, hemorrhagic PED, and fibrovascular scar, which the current clinical imaging data support. The hypothesized unifying feature in these conditions is the replacement of lipid-rich soft druse contents with either fluid or a fibrotic material that is sufficiently hydrated to allow UC supersaturation and precipitation. In our case series, the duration of HCDs was correlated with macular complication subtypes, and particularly the presence of MNV exhibited the longest persistence of...
detectable HCDs. This finding suggests chronic exudation as a contributory mechanism for cholesterol crystal formation.16

We suggest that the appearance, movement, and dynamism of nonliving HCDs are readouts of the status of nearby living cells. It is possible that cholesterol crystals signify RPE degeneration, extrapolating from recent data on calcific nodules (hydroxyapatite) which is a soft drusen end-stage finding appearing as hyporeflective cores on OCT28 and signifying a 4- to 6-fold increased risk for progression to advanced AMD. Because nodules appear concurrently with decreased fundus autofluorescence signal, this risk is attributed to a degeneration of overlying RPE that potentially raises extracellular pH and promotes nodule formation.28 Further, cells in the sub-RPE-BL space along with the crystals include subducted RPE, multinucleated giant cells, presumed macrophages, and collagen-secreting fibroblasts, all of which could move, break up, or resorb crystals.12,22,23,40,57 A similar range of cells associates with cholesterol crystals in Coats disease.20,21 Cholesterol crystals, like calcific nodules, represent end-stages of lipid rich soft drusen, and dead drusen are not a good sign. It is true that soft drusen are a rich source of lipids that are modifiable to become proinflammatory and proangiogenic moieties that elicit local and systemic immune response.56 However, RPE that is capable of maintaining a soft druse through physiologic secretions is probably also able to maintain photoreceptors. Recent cell culture experiments testing the effects of crystal exposure on nonconfluent RPE-derived cell lines have as yet uncertain relevance to our overall pathophysiology model which is based on longitudinal clinical imaging and histology.58,59

Strengths of this study were a longitudinal eye-tracked NIR/OCT follow-up of HCDs in nonneovascular AMD and an analysis identifying both specific multimodal imaging characteristics and HCD turnover as prognostic indicators of worse visual and anatomic outcomes. Limitations of this study included its retrospective nature, the lack of direct comparison to non-HCD AMD, and a lack of direct comparison with non-HCD AMD.

FIGURE 5. Movement and clearance of HCDs associated with retinal pigment epithelium aperture. Serial tracked NIR and SD-OCT B-scans of the right eye of a 77-year-old female. (A) At baseline, single linear hyperreflective HCDs in the fovea on NIR are seen to be clustered in the corresponding OCT B-scans (white circle). (B) One month later, the HCDs are located inferiorly (red circle) from their origin (white circle). (C) Eleven months after baseline, HCDs show partial resorption with further inferior movement (yellow circle). New subretinal fluid overlies a disruption in the retinal pigment epithelium. (D) HCDs were fully resorbed with residual subretinal fluid (gray circle). For further details see also Supplementary Video.
with a control group to assess a definite predictive model, and the use of commercial SD-OCT devices that did not provide raw linear reflectivity data useful for quantifying lesion reflectivity. Despite these limitations, we showed HCDs are a biomarker for the development of late-stage macular complications with clusters of HCDs in NIR adding further negative prognostic value for visual decline, and centrifugal movement associated with growth of CRORA. Further, extrapolating from the recognition of HIRD as an OCT biomarker for progression, high reflectivity and dynamism of HCDs may be amenable to automated recognition and analysis to assess cellular activity in the sub-RPE–BL space. These new data will be useful in addressing the significance of HCDs in non-neovascular AMD that represent the end-stage of the drusen lifecycle preceding late-stage macular complications.

**Acknowledgments**

Supported by The Macula Foundation, Inc., New York, New York, United States, the Honors Center of Italian Universities (H2CU) (SF), Heidelberg Engineering, and Hoffman La Roche (CAC). The Department of Ophthalmology and Visual Science of the University of Alabama at Birmingham receives institutional support from Eyesight Foundation of Alabama and Research to Prevent Blindness, Inc.

Disclosure: S. Fragliotta, None; P. Fernández-Avellaneda, None; M.P. Breazzano, None; C.A. Curcio, None; B.C.S. Leong, None; K. Kato, None; L.A. Yannuzzi, None; K.B. Freund, Genentech (C), Optovue (C), Zeiss (C), Heidelberg Engineering (C), Allergan (C), Novartis (C)

**References**


